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Let’s Put Our Brains Together
and Make an Opera

Lee Ridgway

I t’s called an opera, but bears little
resemblance to Mozart, Verdi, or even
Phillip Glass. Like grand opera, it re-
quires a small army of creators and
production staff, but the performance
lasts less than an hour. It calls for three
on-stage performers, yet its “cast” in-
cludes the audience, which in turn can
include people connected via the In-
ternet. Itis, in short, Brain Opera. This
new work by Tod Machover, com-
poser and Professor in Media Arts
and Sciences, is an experiment in large-
scale multimedia collaboration between
performers, audience, and technology.

Machover is best known for his
hyperinstruments, which use sophisti-
cated technology to merge and extend
the capabilities of musical instruments
and performers. Brain Opera takes his
work with hyperinstruments to a new
level. In a Media Lab Perspectives pre-
sentation on May 14, Machover gave
a behind-the-scenes look at what Brain
Opera is all about.

Three Components

Brain Opera has three components:
two in the physical space of a theater
setting and one in the ethereal space
of the Internet. The theater audience
first enters a lobby in which about 45
interactive, high-tech instruments are
set up — a sort of music arcade. Here
the public plays with the instruments
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and experiments with creating sounds
and music.

The audience then enters the theater,
where what they experienced and cre-
ated in the lobby is incorporated into
the opera. About half of the material is
composed and remains the same from
one performance to the next. The rest
is unique to each performance, as the
performers shape and change the
music contributed by the public.

The third aspect of Brain Opera
happens courtesy of the World Wide
Web. From the Brain Opera Web site,
people can create and submit sounds
that may become part of a performance.
In turn, audio and video from a per-
formance can be broadcast over the
Web.

Underpinnings

While Brain Opera relies on random
contributions for much of its aural
material, it has an underlying premise.
Machover was inspired by Marvin
Minsky’s The Society of Mind, with its
theory that intelligence emerges from
the interaction of independent mental
processes in the brain, often unaware
of each other, rather than from one
single, central “conductor.” In fact,
Minsky is a player in Brain Opera,
through recordings of his own words
and voice.

Brain Opera explores the nature
of intelligence and its connections to
creativity in the realm of music. In a
sense, the contributions of the audience
stand as the independent processes

continued on page 2 »
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BrAaIN OPERA
continued from page 1

which are brought together with the
composer’s material to create a coherent,
artistic whole. Machover hopes that
the audience, by taking part in creating
Brain Opera, will be drawn into the
mysteries of music and the mind,
exploring the interplay of sensory per-
ception, musical structure, language,
memory, thinking, and emotion.

Instruments in the Lobby

Because it is where the audience
really gets to play, the lobby environ-
ment is of primary interest. Artfully
designed by Ray Kinoshita, the lobby
contains an impressive amount of
futuristic-looking technology.

You first enter a forest of tree-like
structures. Each tree offers a different
experience. Some trees invite your
responses to Minsky’s recorded com-
ments and questions about music.
Other trees ask you to sing a single
note, around which the tree harmo-
nizes and generates its own music.

Further into the lobby, you encoun-
ter a variety of hyperinstruments. In
his talk, Machover described several
of these in detail. Harmonic driving is

a lot like a traditional video game,
combining music with 3-D graphics.
You sit in front of a screen and drive
through music using a steering wheel,
joystick, and pedals. The music is trans-
formed by how you drive. Stay on the
main road and the music continues in
a pleasant, somewhat bland way. Make
twists and turns or change speed, and
the music changes significantly. Slam
into the roadside and you get a musi-
cal crash.

The melody easel offers the exper-
ience of playing a sophisticated solo
instrument such as a violin, as a way
of exploring how melody works. On
a very touch-sensitive screen, you con-
trol the color, phrasing, and articulation
of the sound, which is reflected in the
trace of a watercolor-like graphic.
Simple, steady movements produce
a pure melodic line; add wiggles and
you add ornaments; more vigorous
motion leads to a more distorted,
“electronic” sound.

At the gesture wall, several people
gather around to form a kind of small
musical ensemble. A rear-projection
screen displays visual renderings of
music fragments on a translucent wall.
Sensitive motion-detecting technology,
including doppler radar, measures
each player’s gestures. These trans-

MITVMA/C Web Pages Keep
VM Server Users Up to Date

The IBM VM Server in MIT’s Data
Center runs several Institute-critical
administrative applications, including
Admissions, Alumni, Payroll, Pension,
Investments, the CAO application, and
$SUmMMIT. It also acts as a gateway for
e-mail and provides a backup option
for campus computer users (ADSM; see
the April 1996 i/s), among other services.

The server runs the vm/EsA operat-
ing system, and is commonly referred
to by its two partitions — mitvma and
MITVMC. MITVMA offers public access
via MITnet and the Internet; mitvmc
has security restrictions.

If you use mitvmAa/Zc and have a
Web browser such as Netscape on your
desktop computer, you may want to
bookmark the mitvma/Zc Web pages at

http://mitvma.mit.edu/system/
htbin/system
or
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http://mitvmc.mit.edu/system/
htbin/system

The mitvma and mitvmc Web pages
contain links to

- A What’s New file that documents
machine configuration changes,
software upgrades, and other news

= A system configuration chart
- A service schedule

= Live system information, including
system status and usage and the
current logon message

= |Information about how to connect
to MITVvmMAZC

= Information about the vm/EsAa
system at MIT, including rates,
monthly statements, and help files

If you have feedback on the mitvma/Zc
Web pages, click on the Comments link
to send e-mail to the I/T Service Web-
masters. For questions about mitvma/Zc
services, contact the Help Desk at x3-
7230 or <mithelp@mit.edu>. g

form, modify, and perturb the music
as it flits by on the wall.

The rhythm tree, closest to a tradi-
tional instrument in how it looks and
how you play it, is a sculpture of
many drums. Each drum pad is a small
computer, and there are 320 in all that
combine into one giant parallel com-
puter. These computers respond to what
one or more players do on the pads,
creating other sounds and rhythms
throughout the whole system.

Recordings made at the trees and
on the hyperinstruments are filtered
into the performance through a com-
plex network.

Upcoming Performances

Brain Opera premieres on July 23, at
the Julliard School in New York City,
as part of the Lincoln Center Festival.
The New York City run, which includes
several performances a day, will end
on August 3. Future stops include
Tokyo and Singapore.

Members of the MIT community
can get a preview at dress rehearsals
in the Media Lab on July 6 and 7; for
reservations call x3-5300 or send mail
to <tickets@brainop.media.mit.edu>.

For more information about Brain
Opera and Web participation, go to

http://brainop.media.mit.edu [7]
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Corel’s WordPerfect Suite 7
Packs a Lot of Punch

Gail Garfield Neuman

C orel Corporation purchased the

WordPerfect Suite of business appli-

cations and related software from

Novell, Inc. on January 30 of this year.

This makes Corel the second largest

software company in the world. They

brought WordPerfect into the 32-bit

arena last month with the release of

WordPerfect Suite 7.0 for Windows 95.
This new suite includes a host of

applications, including

= WordPerfect 7

= Quattro Pro 7 (spreadsheet)

- Presentations 7

= Envoy 7 (workgroup publishing)

- AT&T World Net Services software
including Netscape

= CorelFLOW 3 (business graphics)

- SideKick 95 (personal information
manager and scheduler)

= Dashboard 95 (application and
task launcher)

= 150 fonts and 10,000 clipart images
The Professional version, Corel

Office Pro, adds

= InfoCentral (information tool)

- Paradox 5.0 (database)

= GroupWise 4.1 client (mail)

- 1000 fonts

= Corel Office Professional
developer’s kit

= Corel Draw 6 (may be part of the
early releases as an incentive)

System Requirements
The system requirements for the
full suite are

= Windows 95 OS

= A 486/25 machine or higher (a
486/66 machine is recommended)

= 2X CD-ROM or faster

- 8MB RAM (16MB is recommended)
= VGA monitor

= A mouse or tablet

= 30-220MB of hard disk space, de-
pending on the options installed

If you use only WordPerfect 7,
your system requirements will be at
the lower end.

CORE [ Ca
WordPerfect” s

Suite Integration

Corel offers significant integration
of the Suite’s three core applications —
WordPerfect, Quattro Pro, and Presen-
tations. They have common interface
tools so that you don’t have to switch
gears when you move from one to the
other. They share the same Address
Book and Dictionary. All three work
with automation tools such as Quick-
Task, QuickFormat, and QuickArt. For
example, all of the core applications
can use the QuickTask that creates
HTML documents for the Web.

While these programs are highly
integrated, be aware that IS offers full
support for WordPerfect 7 only. Since
WordPerfect is in wide use at MIT, it
will be the focus for the remainder of
this article.

Formatting Features

Corel has introduced several ways
to simplify the formatting of Word-
Perfect documents. The Document
window now has different colored
guidelines for each document part
(tables, margins, columns, header/
footer). You can use these guidelines
to manually adjust the margins of a
page, paragraph, or document part.

HotSpots are little square buttons
that appear at the start of every para-
graph or in the active cell in tables.
Hotspots give you easy access to con-
text-sensitive formatting commands,
such as putting a border around a
paragraph. Similarly, right-clicking
your mouse button almost anywhere
in a document drops down a Quick-
Menu of context-sensitive features.

You can use the QuickCorrect fea-
ture to create horizontal lines, indents,
and bullets as you type. Spell-As-You-
Go flags potential misspellings as they
happen.

The Shadow Pointer shows you the
position of your insertion point should
you choose to click the mouse button.

Templates

WordPerfect can do a lot of your
work for you. The program offers sev-
eral “Experts” that can help you fill
out templates. And there are lots of
templates — for resumes, letterheads,

greeting cards, and much more. Three
templates for term papers are based
on popular style guides (APA, MLA,
and Turabian).

Getting Help

WordPerfect Help has been im-
proved in every way. The main point
of entry is the Help menu; from there,
you can choose a variety of ways to
access the Help system. If you choose
the Help Topics option under the
Help menu, you can use a table of
contents, an index, or a search mech-
anism to select relevant topics.

The Help Topics “Show Me” tab
offers a more visual approach to Help.
You can play film clips of how a task
is done. (You need the CD version of
the WordPerfect Suite to do this.)
You can choose “Guide me though it”
demos (formerly Coaches) that take
you through a task step by step. You
can even select “Do it for me” to see if
there are QuickTasks to get the job done.

Another Help option is “Ask the
PerfectExpert,” a built-in consultant
that answers questions phrased in
everyday English (“How do | convert
footnotes to endnotes?”).

Upgrade Help compares the names
and functions of WordPerfect’s features
with those in other word processors,
and shows you how to step through
chosen tasks in WordPerfect. This is
handy if you’ve switched from another
word processor and want to get up to
speed quickly.

In addition to WordPerfect’s built-
in help, the Corel Web site at

http://www.corel.com

has a Searchable Knowledge Base in
the Service and Support area.

Last but not least, Corel has re-
instituted free technical support for
registered users. You do have to pay
for the toll call to (801) 765-4041.

Auvailability and Pricing

The MIT Computer Connection in
W20-021 sells WordPerfect Suite 7 for
Windows 95 and Corel Office Pro at
a significant educational discount.
WordPerfect Suite 7 sells for $35; Corel
Office Pro costs $115. Both programs
come on CD only. If you need the pro-
gram on 3.5" diskettes, you will need
to buy the CD version and send Corel
the request form for diskettes that’s
included inside the package. @
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Use Your Web Browser to
Access Network News

John Saylor

I f you like to keep up with current
events, or enjoy discussing a favorite
topic with other aficionados, check
out Network News (NetNews). Also
referred to as Usenet (for Users Net-
work), NetNews is the umbrella term
for a worldwide electronic forum. Net
News provides two primary services:
= Itis an information source, equiva-
lent to an online newspaper. Infor-
mation services, such as ClariNet,
provide news from United Press
International and other sources.

= Itis aforum for posting and read-
ing messages on topics of all kinds.
Newsgroups are arranged hierar-
chically, from broad categories to
specific subgroups, and this is re-
flected in their names. For example,
a newsgroup on ragtime music,
rec.music.ragtime, is in the top-
level domain rec.* (recreation),
in the music sublevel.

Built-in Newsreaders

In the past, you needed a stand-
alone program to access NetNews.
Today, most Web browsers have a
built-in newsreader; this integration
offers somes nice advantages.

= URLs in articles are live. You can
click and surf.

= Binary formats (pictures, executable
files) can be handled automatically
by a correctly configured browser.

= You can read a newsgroup by enter-
ing its URL (e.g., news:alt.angst).

Setting up your Browser

Configuring your Web browser to
read NetNews is straightforward. The
steps detailed here use Netscape 2.x,
which you can get from MIT’s network
software ftp site, net-dist.mit.edu. If
you use another browser, you can still
use the instructions here as a guide.

First, point your Web browser to
the MIT Network News Transport

Protocol (NNTP) server, news.mit.edu:

1. Open the Options menu.

2. Select the Mail and News Prefer-
ences... menu item.

3. Click on the Servers tab.
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4. Enter news.mit.edu in the News
(NNTP) Server field in the lower
part of dialog box, and click OK.

Reading News

You're now set to read news. Go
to your browser’s Window menu and
select Netscape News. This opens a
newsreader window with three panes.

The upper left pane displays your
newsgroup subscriptions. You should
see an icon for your NNTP server and
three default newsgroups:

< news.announce.newusers
- news.newusers.questions
< news.answers

The first two newsgroups are good
starting points for learning about Use-
net culture. News.answers contains
Frequently Asked Questions (FAQS)
for all the NetNews newsgroups.
Note: If you see newsgroup icons
without names, you need to widen the
News Server field. To do this, move your
cursor between the News Server and
Check Mark fields in the gray bar above
the pane. When the cursor turns into
a double-headed arrow, press your
mouse button and drag to the right.

Selecting and Reading Newsgroups

To get a listing of all newsgroups,
open the Options menu, then select
Show All Newsgroups. You may get a
dialog box warning you that this will
take time. On an MITnet Ethernet
drop, the wait shouldn’t be too long,
but over a PPP link such as Tether,
it may take several minutes.

When you click on a newsgroup,
the upper right pane displays current
unread articles grouped by thread
(subject). You can sort articles by sev-
eral criteria; click on the View menu,
then select Sort. When you click on a
message you want to read, it appears
in the large lower pane. Since you read
NetNews articles on a server, they
don’t take up room on your hard disk.

To subscribe to a Newsgroup, open
the File menu and select Add News-
group. When the dialog box appears,
enter the newsgroup’s name.

Suggested Stops

NetNews is a sprawling online phe-
nomenon. If you’re just starting out, you
may want to browse alt.* (alternative),
clari.* (ClariNet news), rec.* (recreation),
and mit.* (local interest). @

Computer Corner

This column presents news and tips
from the consultants who staff the
Computing Help Desk, x3-0001.
Check out their Web home page at
http://computing-help.mit.edu/

'I I recently installed System 7.5
[y

Update 2.0 on my Macintosh,
which updated my operating system
to version 7.5.3. Now | hear that Apple
Computer has released a revision to
System 7.5.3. Is this an important revi-
sion and if so, where do | get it?

A According to Apple, the follow-
ing systems will benefit from
System 7.5.3 Revision 2:

= All PowerBooks using Connectix
RAM Doubler

= All PowerBook 5300 and Power-
Book Duo 2300 systems

= All PowerBook 200 or 500 Series
systems that have been upgraded
with the Macintosh PowerBook
Processor Card Upgrade Kit with
PowerPC (or with a similar third-
party product)

= All Macintosh 7200, 7500, 7600,
8500, and 9500 systems

The most important bug fixes in
System 7.5.3 Revision 2 are for Power-
Books. PowerBooks running versions
of Connectix RAM Doubler (1.6.1 or
earlier) now wake up properly from
sleep mode. Problems associated with
formatting PC disks in PowerBook
500s with PC upgrade cards have been
fixed. Overall performance on Power-
Books with PowerPC upgrade cards
has also been improved.

You should install System 7.5.3
Revision 2 only on computers running
System 7.5.3, or on PowerBooks run-
ning System 7.5.2, with PowerBook
Enabler 1.2 or later.

To get the updater, copy the Net
Install folder from the CSS File Server
in the IS-CSS AppleTalk zone. The
path is Public:AppleSoftware:System
Software:System 7.5.3, Revision 2:
Net Install.

For more specifics, go to the Apple
Tech Info Library at
http://til.info.apple.com/til/
til.html

and search on the term “System 7.5.3
Revision 2.” This should yield a FAQ and
an Overview and Installation file. @
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The MCC Revamps Its Trade-Up
Program

Ginny Williams

The MIT Computer Connection has
sponsored a Trade-Up Program for
several years. This program let you
trade in a used Macintosh for credit
toward a new one.

Starting this month, the MCC is
introducing changes that should im-
prove the trade-in process. You can now

= Deal directly with the Computer
Loft, a used Macintosh vendor, at
a monthly event held in the MCC.

= Sell non-Macintosh equipment and
multiple computers from an office
or lab (by making arrangements
with the Computer Loft, which
may in turn contact other vendors).

= Receive a check for your equip-
ment, rather than a credit voucher
that must be used at the MCC.

Computer Loft representative Craig
Marin will process trade-ins at each
event. To get the latest pricing on used
computers, contact Marin directly at
738-9997 or <CompLoft@aol.com>.

The Way It Works

The monthly trade-up events will be
publicized in advance through MCC
News Flashes, fliers, and ads in The Tech
and other student newspapers.

On the day of the event, you bring
in the equipment you want to sell,
have it tested by Marin, and receive a
check made out to you or your depart-
ment, depending on ownership.

MIT-owned equipment needs
to be pre-approved for sale by MIT’s
Property Office: you must present a
valid Property Release form at the
time of sale.

If you're trading in your own equip-
ment, you must fill out a Statement
of Ownership form. If you’re trading
in Macintosh equipment that you

bought from the MCC within the last
year, you’ll also need to fill out a one-
year purchase exception form. (Under
the MCC'’s purchase program with
Apple, qualified students, faculty, and
staff can buy only one Apple desktop
computer, PowerBook, Newton, laser
printer, and inkjet printer per year.)

Equipment Prep

In addition to filling out the requi-
site forms, you need to prepare your
equipment for trade-in:

= Remove all files and programs from
your hard drive except the System.
(If you have sensitive data on your
hard drive, you may want to refor-
mat it and reinstall the system.)

= Clean the outside case and remove
any stickers or marks.

Schedule and Forms
You can find the trade-in schedule
and related forms on the Web at

http://web.mit.edu/mcc/www/

The same materials are also posted in
the MCC'’s Trade-Up Program folder
on Techinfo. o

Summer Computer Courses and
Quick Starts Are Set to Begin

Jeanne Cavanaugh

The IS Training Services group be-
gins its summer quarter of hands-on
computer courses and Quick Start
classes on July 8 — with its usual em-
phasis on training for the Macintosh
and Windows environments. The
hands-on courses and modules, which
are fee-based, can help you become
proficient in selected applications that
are popular on campus. Featured soft-
ware includes Microsoft Word, Excel,
FileMaker Pro, Microsoft Access, Micro-
soft Project, PageMaker, Photoshop,
and PowerPoint.

Quick Start demonstration classes,
which last about an hour, are free. They
are intended to help you get started
with a new computer and with com-
monly used software.

Web-Related Offerings

Training Services also offers classes
to help you learn about the world be-
yond your office. For those new to the
World Wide Web, there is a hands-on

course on Exploring the Internet. At
least one World Wide Web Quick Start
class is held each month.

If you want to learn how to publish
on the Web, you can take Electronic
Publishing Using HTML (this course
has different sections for Macintosh
and Windows users). A free, monthly
HTML demo lasts about three hours
and is a prerequisite for the hands-on
course.

Business Modules

Training Services continues to offer
modules on the CAO and $SumMIT
applications, as well as a module on
Electronic Time Sheets and Journal
Vouchers. These systems will remain
in use at MIT while the new SAP
financial package is phased in.

Ergonomics

If you work daily with computers
or manage a staff that does, consider
taking the course on Preventing Re-
petitive Strain Injuries (RSIs). You will
find out about suspected risk factors,
learn how to adjust furniture and equip-
ment, and practice prevention strate-
gies for common physical problems.

Course Catalog and Registration

For a complete listing of course
descriptions and Quick Start classes,
along with dates, times, and fees, see
the IS Summer *96 Computer Training
Catalog. If you didn’t receive a copy
and would like one, contact Training
Services at x3-7685 or <wray@mit.edu>.

You can check an updated sched-
ule of courses and Quick Starts via
the Training Services Web page at

http://web.mit.edu/tps/www/
training/

This page also has a link to an online
course registration form. It is the same
as the form at the back of the paper
Catalog, except that you fill it out on-
line and send it in via e-mail.

From the online registration form,
you can access EREQ (MIT’s Electronic
Requisitioning System). Authorized
EREQ users can use the system to pay
for courses. Whether
you opt for paper or
online methods, re-
member to submit
both a registration
form and requisition
for each course. @
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Searching MIT Web Pages
Using Harvest

Robyn Fizz

The Institute’s official World Wide
Web server, web.mit.edu, hosts over
24,000 Web pages, and that number
grows daily. These Web pages are
a very rich source of information, but
finding the information you want by
“wandering” from link to link may
not always be very effective.

For this reason, Information Systems
has provided search capabilities from
the MIT Home Page at

http://web.mit.edu/

These search capabilities are powered
by Harvest, an “information discovery
and access system” that is uniquely
suited to MIT’s complex network
environment.

What Is Harvest?

Harvest was designed and built by
the Internet Research Task Force Re-
search Group on Resource Discovery,
based at the University of Colorado.
It is an integrated set of tools to gather,
organize, and replicate relevant infor-
mation across the Internet.

The central parts of the Harvest
system are the Gatherer and the Broker.
The Gatherer provides an efficient,
customizable way to collect indexing
information from a set of Web pages.
The Broker takes the Gatherer’s infor-
mation and builds a searchable index.
The Broker also provides the system’s
user interface: you use the Broker
when doing a search.

To find out more about Harvest,
visit the Harvest Web page at

http://harvest.cs.colorado.edu/

Harvest at MIT

At MIT, Harvest has been set up to
index the web.mit.edu server once a
week. The Gatherer starts from the MIT
Home Page, and collects every URL
that starts with http://web.mit.edu/
and ends with / or .html or .htm

Users at MIT can search this index
via a search field at the bottom of the
MIT Home Page. Keep in mind that
searching on a single word (like “html”
or “computer”) may take a lot of time,
and return far more results than are
helpful. More focused queries usually
get better results in less time. At MIT,
Harvest works with the Glimpse search
engine, which supports several types
of queries:
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= Structured queries (which let you
constrain matches to certain fields)

= Boolean (AND/OR) combinations
of keywords

= Case-insensitive or case-sensitive
queries

= Matches to parts of words, whole
words, or multiple word phrases
(like “resource discovery™)

= Approximate matches (which allows
for spelling errors)

= Matched lines or entire matching
records (e.g., for citations)

= Limits on the number of matches
returned

= “Wild card” expressions; for
example, matches to all words
ending in a particular suffix)

You can specify these options with
buttons and menus in the Extended
Search query form. (Follow the link
at the bottom of the MIT Home Page.)
Structured queries are very useful
for refining searches. For example, you
can limit a search to find matches only
when a specified term appears in a title
or heading of an HTML document.
This is more likely to return relevant
matches than a full-text search. Simi-
larly, if you are looking for images re-
lated to a certain topic, you can limit
the search to HTML image references.
For help in formulating queries for
effective searches, see

http://web.mit.edu/cwis/search/
queryhelp.html

Other MIT Web Servers

While Harvest is a powerful system,
it cannot search all the Web pages at
the Institute. Many Web pages at MIT
are not searchable through Harvest
because they reside on servers other
than web.mit.edu, and are not “gath-
ered” when Harvest creates its index.
In the future, other servers may be
integrated into the Harvest system.

Many of these other MIT servers
have search capabilities of their own.
Some of the best-known ones include:

- Barton
telnet://library.mit.edu
= Materials Science and Engineering

http://tantalum.mit.edu/
search.html

= Mechanical Engineering
http://me.mit.edu/bin/search

= The MIT Student, Faculty, and Staff
Directory
http://web.mit.edu/cwis/www/
mitdir/index.html

= Registrar’s Office Subject Listings
and Schedule
http://registrar.mit.edu/
catalog

= Techlnfo
http://web.mit.edu:1962/
tiserve.mit.edu/9000/0/Search

= The Tech
http://the-tech.mit.edu/cgi-
bin/search

Outside Search Engines

You can also search MIT’s Web
pages using any of a variety of outside
search engines. Information Systems
recommends the Alta Vista search en-
gine at
http://www.altavista.digital.com/

You can use query syntax that limits
the search to mit.edu. For example, to
search MIT Web pages for the word
“photosynthesis,” use the search
string

photosynthesis +url:mit.edu

Validate Those Pages!

As mentioned earlier, the current
Harvest search service does not index
MIT Web pages if they aren’t part of
web.mit.edu hierarchy. In addition,
Harvest will not index Web pages
with invalid HTML code (for example,
an HTML reference that doesn’t have a
closing quotation mark).

If you are a Web publisher and
want to be sure that your HTML code
is valid, try one of the automatic vali-
dation services on the Web. IS recom-
mends the Kinder, Gentler Validator
at

http://lugweb.cs.ualberta.ca/
~gerald/validate/

More Information

For more details about searching
MIT’s Web pages, go to
http://web.mit.edu/cwis/search/

You can also post questions and com-
ments to the browsable discussion list
<mitsearch@mit.edu>.

Much of the material in this article is
based on information posted on the
Web by Bruce Lewis, the Information
Systems programmer who is coordinat-
ing the Harvest search service at MIT.


http://web.mit.edu/
http://harvest.cs.colorado.edu/
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telnet://library.mit.edu
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http://me.mit.edu/bin/search
http://web.mit.edu/cwis/www/mitdir/index.html
http://registrar.mit.edu/catalog
http://web.mit.edu:1962/tiserve.mit.edu/9000/0/Search
http://the-tech.mit.edu/cgi-bin/search
http://www.altavista.digital.com/
http://ugweb.cs.ualberta.ca/~gerald/validate/
http://web.mit.edu/cwis/search/

MIT Electronic Catalog
Reaches Prototype Phase

Lee Ridgway

A key part of the Institute’s

reengineering effort in the area of
Supplier Consolidation has been the
development and implementation of
the MIT Electronic Catalog. This Web-
based system will let authorized users
order routine goods and services di-
rectly from suppliers with whom MIT
has established special partnerships.

MIT ECAT will give members of
the community access to a supplier’s
online catalog, customized for MIT.
Authorized users will be able to place
orders electronically without the need
for requisitions, purchase orders, in-
voices, or additional approvals. The
savings in time and paperwork
should be significant.

A Web Prototype

After more than a year’s work, MIT
ECAT has reached the prototype phase.
Two vendors — Office Depot and VWR
Scientific — have been active participants
in the Catalog’s development. MIT
ECAT is now up on the Web at

http://web.mit.edu/ecat/

Anyone at MIT with a computer
connected to MITnet and a Web
browser such as Netscape can use MIT
ECAT to look at these two vendors’
online catalogs. Note: The prototype
may not be accessible to computers
on certain subnets at MIT, and it is
not available outside of the Institute.

You find items in the online cata-
logs by browsing through product
categories, searching on keywords,
or searching for catalog numbers.
Product pages in the catalogs include
color photos, product descriptions, and
MIT’s discounted price. One advan-
tage of the online catalogs is that they
will be updated more frequently than
printed versions.

You can even prepare an order
using the prototype system — up to
a point. (Currently, only authorized
testers can complete orders.)

Order Placement

While anyone on MITnet can
browse the catalogs, to place an order
you must be issued an MIT Procard,
the Institute’s corporate charge card
from American Express. Procard au-
thorizations will be based on MIT’s
current purchasing authorizations.

To answer concerns about authen-
tication and security of information in
Internet-based transactions, a concur-
rent development with MIT ECAT has
been a Web helper application called
Ksign. Related to MIT’s Kerberos
authentication system, Ksign will
authenticate a person placing and
“signing” an MIT ECAT order.

Testing

The MIT ECAT prototype is cur-
rently being tested by a small group
of people in offices and departments
throughout the Institute. Results from
this round of testing will be evaluated,
and the developers will be given feed-
back about suggested changes or bugs
that need to be fixed.

Other Feedback

In May, the MIT ECAT Implemen-
tation Team presented demonstrations
of MIT ECAT to members of the Ad-
ministrative Advisory Council. These
presentations included discussion of
issues around MIT ECAT procedures
and purchasing policies.

The Implementation Team also
welcomes your comments, suggestions,
and questions. You can contact the
team via e-mail at <ecat@mit.edu>. @

An Update from the Access
Technology Lab

Mary Ellen Bushnell

-I_ucked away in 11-112, beside the
Athena Fishbowl, is the Access Tech-
nology for Information and Comput-
ing (ATIC) Lab. Since it opened in
1990, the Lab has provided consulta-
tion, configuration, training, and on-
going support on access solutions for
MIT students and employees with dis-
abilities. The Lab is also committed to
educating the MIT community about
access issues and technology.

A New Coordinator

The ATIC Lab’s first coordinator,
M. Susan Jones, left the Institute in
December. Her replacement, Kathy
Cahill, started at MIT in late May. A
licensed social worker, Cahill worked
for seven years as a rehabilitation en-
gineer in adaptive technology for the
Massachusetts Commission for the
Blind.

Since starting at MIT, Cahill has
been getting familiar with the Lab, its
clients, and other Institute offices, in
particular the Disabilities Services
Office (DSO). The Lab and the DSO
confer on adaptive technologies to
meet a wide variety of client needs.
They are planning technical and ad-
ministrative ways to support disabled
students needing accommodations for
classes in the fall. The two offices also
collaborate on needs assessment and
computing solutions for clients with
serious repetitive strain injuries.

Lab Improvements

Planned purchases for the Lab in-
clude a new Pentium PC, a DECTalk
synthesizer, and more alternative
keyboards and mice that clients can
evaluate at their worksites.

In the area of software for the vis-
ually impaired, the Lab plans to test
Windows 95 screen readers; explore
access to graphical environments and
to scientific and mathematical materi-
als; and research alternative formats
for reading books online. The Lab

will also investigate software aids for
people with learning disabilities.

More student consultants will be
hired and trained over the summer.
Within a few months, the Lab will be
staffed and open 40 hours a week
during normal business hours.

Finally, given the Lab’s size (it barely
meets space requirements for wheel-
chair access), long-term plans include
seeking out a space with more room
for clients and equipment.

For More Information

The ATIC Lab has staffed hours
posted on its door. At these times, you
can come to the Lab to ask technical
guestions, schedule training sessions,
or talk to an on-duty consultant. To
set up an appointment with a staff
member, call x3-7808 <atic@mit.edu>.
Kathy Cahill also has an office in 11-
316. She can be reached at x3-5111.

To find out more about the ATIC
Lab, visit its Web page at
http://web.mit.edu/atic/iwww/
atic.html 2
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Q/J Getting Help

If you don’t know where to get help For help with... Dial... Or send a message to...

for your computer, network, or ] ] ]

telephone problems, call the IS Help Athena Computing Environment 3-4435 olc@mit.edu

Line, x3-2001 — or direct dial one of Athena hardware repairs 3-1410 hotline@athena.mit.edu

theht]elp I'”ei I'SttEd to t:‘e trlgh.t. . Computer sales 3-7686 mcc@mit.edu

you prefer to use electronic mail, L

you can send your questions to the DEC and Sun software 3-6320 help@isis.mit.edu

corresponding addresses on the far Disabilities and computing 3-7808 atic@mit.edu

right. (When logged into Athena, IS mainframes 3-7230 mithelp@mit.edu

you can also use the olc Commaf?d Microcomputer and printer repairs ~ 3-0815 pcservice@mit.edu

to send questions to Athena’s online . ) )

consultants.) Microcomputer use 3-0001 micro-help@mit.edu
Networks/MITnet 3-4101 net-help@mit.edu
Telephone repairs 3-4357 5help@mit.edu
Voice mail 3-3677 vmail@mit.edu

Recent Publications from Information Systems

These publications are free. You can Order No. - Title

pick up copies in the MIT Computer Z

Connection, W20-021, or in the racks NS-47 . Setting up Microsoft IP in Windows 95 for MITnet (ethernet)
outside E19-630. Some of these publi- " http://web.mit.edu/win95/e-msipg.html

cations are on the World Wide Web. NS-48 Setting up Microsoft IP in Windows 95 for Tether (dialup)

To view them, use the URLs listed

http://web.mit.edu/tps/www/win95/t-msip/ppp95.html
beneath the titles. P p p/ppp

You can also request IS publications QG-8 - Basics of Using Netscape
by calling x3-5150 or sending e-mail QG-44.3 . ADSM Version 2 Backup for the Macintosh: Quick Start for
to <sendpubs@mit.edu>. ~ Individual Users (revised)
* http://web.mit.edu/tps/www/QG/QG-44/ADSM_Mac.html
RP-5.1 - Brush up Your Computer Skills with IS Training Services
. (revised)
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Have a good summer. i/s will be back in September.
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